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Copyright and Legal Disclaimer
Copyright © 2006-2008 Dialogic Corporation. All Rights Reserved. You may not reproduce this document in whole or in part 
without permission in writing from Dialogic Corporation at the address provided below.

All contents of this document are furnished for informational use only and are subject to change without notice and do not 
represent a commitment on the part of Dialogic Corporation or its subsidiaries ("Dialogic"). Reasonable effort is made to ensure 
the accuracy of the information contained in the document. However, Dialogic does not warrant the accuracy of this information 
and cannot accept responsibility for errors, inaccuracies or omissions that may be contained in this document.

INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH DIALOGIC® PRODUCTS. NO LICENSE, EXPRESS OR 
IMPLIED, BY ESTOPPEL OR OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS IS GRANTED BY THIS DOCUMENT. EXCEPT 
AS PROVIDED IN A SIGNED AGREEMENT BETWEEN YOU AND DIALOGIC, DIALOGIC ASSUMES NO LIABILITY WHATSOEVER, 
AND DIALOGIC DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF DIALOGIC PRODUCTS 
INCLUDING LIABILITY OR WARRANTIES RELATING TO FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, OR 
INFRINGEMENT OF ANY INTELLECTUAL PROPERTY RIGHT OF A THIRD PARTY.

Dialogic products are not intended for use in medical, life saving, life sustaining, critical control or safety systems, or in nuclear 
facility applications.

It is possible that the use or implementation of any one of the concepts, applications, or ideas described in this document, in 
marketing collateral produced by or on web pages maintained by Dialogic may infringe one or more patents or other intellectual 
property rights owned by third parties. Dialogic does not provide any intellectual property licenses with the sale of Dialogic 
products other than a license to use such product in accordance with intellectual property owned or validly licensed by Dialogic 
and no such licenses are provided except pursuant to a signed agreement with Dialogic. More detailed information about such 
intellectual property is available from Dialogic's legal department at 9800 Cavendish Blvd., 5th Floor, Montreal, Quebec, Canada 
H4M 2V9. Dialogic encourages all users of its products to procure all necessary intellectual property licenses 
required to implement any concepts or applications and does not condone or encourage any intellectual property 

infringement and disclaims any responsibility related thereto. These intellectual property licenses may differ 

from country to country and it is the responsibility of those who develop the concepts or applications to be aware 

of and comply with different national license requirements. 

Dialogic, Dialogic Pro, Brooktrout, Cantata, SnowShore, Eicon, Eicon Networks, Eiconcard, Diva, SIPcontrol, Diva ISDN, TruFax, 
Realblocs, Realcomm 100, NetAccess, Instant ISDN, TRXStream, Exnet, Exnet Connect, EXS, ExchangePlus VSE, Switchkit, 
N20, Powering The Service-Ready Network, Vantage, Connecting People to Information, Connecting to Growth, Making 
Innovation Thrive, and Shiva, among others as well as related logos, are either registered trademarks or trademarks of Dialogic. 
Dialogic's trademarks may be used publicly only with permission from Dialogic. Such permission may only be granted by 
Dialogic's legal department at 9800 Cavendish Blvd., 5th Floor, Montreal, Quebec, Canada H4M 2V9. Any authorized use of 
Dialogic's trademarks will be subject to full respect of the trademark guidelines published by Dialogic from time to time and 
any use of Dialogic's trademarks requires proper acknowledgement. 

Microsoft, Windows Server, and Windows are registered trademarks of Microsoft Corporation in the United States and/or other 
countries. Other names of actual companies and products mentioned herein are the trademarks of their respective owners.
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Dialogic Corporation License Agreement For Use of Software
This Software License Agreement ("Agreement") is a legal Agreement for the conditional use of the software 

provided herein ("Program") between you, the end-user, whether an individual or a company and all of its 

authorized users of the Program ("You"), and Dialogic Corporation ("Dialogic"). By downloading, copying or 

otherwise using the Program, You agree to be bound by the terms of the foregoing license. 

YOU ASSUME RESPONSIBILITY FOR THE SELECTION OF THE PROGRAM TO ACHIEVE YOUR INTENDED RESULTS, AND FOR 
THE INSTALLATION, USE, AND RESULTS OBTAINED FROM THE PROGRAM.

The Program may contain certain software applications and portions of applications which are provided to You under terms 
and conditions which are different from this Agreement (such as open source or community source), or which require Dialogic 
to provide Customer and its Subsidiaries with certain notices and/or information ("Excluded Code"). Dialogic will identify such 
Excluded Code in a text file or about box or in a file or files referenced thereby (and shall include any associated license 
agreement, notices and other related information therein), or the Excluded Code will contain or be accompanied by its own 
license agreement. Your use of the Excluded Code will be subject to the terms and conditions of such other license agreement 
solely to the extent such terms and conditions are inconsistent with the terms and conditions of this Agreement or are required 
by such other license agreement.  By using or not uninstalling such Excluded Code after the initial installation of the Excluded 
Code You acknowledge and agree to all such license agreements, notices and information. 

License

Under the terms and conditions of this Agreement:

• You may install and use one copy of the Program on a single-user computer, file server, or on a workstation of a local area 
network. 

• Some or all functions of the Program may be available solely if the Program is used with one or more legally acquired Dialogic 
Activation Key(s).

• To obtain an Activation Key You must first purchase a Proof of Purchase Code (PPC).  A PPC may be included in Your software 
or hardware package or You may have to purchase it separately.

• You will receive Your Activation Key upon registering the Proof of Purchase Code as directed in the PPC document.

• It may be possible to install multiple Activation Keys into the Program; in such a case, the total functionality provided by 
the Program will be the sum of the licensed functionalities controlled by the installed Activation Keys as long as the maximum 
capabilities of the Program are not exceeded and the functionalities are compatible.

• Your Activation Key(s) will restrict Your use of the Program. At least one of the following restriction schemes will be available 
to You when You register each PPC and request an Activation Key.

• The Activation Key may be associated with a specific Dialogic hardware device. In this case, the licensed functionality 
controlled by the Activation Key will be available solely if the same Dialogic hardware is present in the computer.  You 
can move the Program to another computer solely if You move the specified Dialogic hardware to the new computer.

• The Activation Key may be associated with a specific Dialogic-supplied software protection device (‘dongle’). In this case, 
the licensed functionality controlled by the Activation Key will be available solely if the same dongle is present in the 
computer.  You can move the Program to another computer solely if You also move the dongle to the new computer.

• The Activation Key may be associated with Your specific computer hardware platform. In this case, the licensed 
functionality controlled by the Activation Key will be available solely if no significant change is made to the hardware 
installed in the computer.  Replacement Activation Keys may be issued at the discretion of Dialogic solely if Dialogic can 
determine that You have not moved the Program to another computer.  Sufficient information must be provided to Dialogic 
to allow it to make that determination.

• In addition to the above restrictions, each Activation Key may have a specific term of use commencing from the date of PPC 
registration.  In this case, the licensed functionality controlled by the Activation Key will not be available after the Activation 
Key has expired.

• The Activation process requires that You enter the following information into the web-based system to obtain an Activation 
Key:

• PPC

• The Device ID provided to You by the "Activation" function in the Program

• Your email address so that the Activation Key can be delivered to You by email

• Dialogic will retain the information above for the following purposes:

• Validation of future requests from You for replacement Activation Keys

• Sending renewal reminders to You in the case of limited time licenses.

• If the Dialogic hardware device that Activation Keys are associated with is judged to be defective by Dialogic following its 
standard practices, Dialogic’s Support department will issue to You replacement Activation Keys associated with the 
replacement device upon receipt of the faulty device by Dialogic.  Replacement of the faulty device is subject to the terms 
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of Dialogic's standard Hardware product Warranty in effect at the time You purchased the hardware product concerned 
("Hardware Warranty").  If a valid Advance Replacement Insurance policy contract is in place for the Dialogic hardware 
product concerned, Dialogic will endeavor to expedite provision of Activation Keys associated with the replacement device.

• If the Dialogic-supplied software protection device (a "dongle" or "USB-stick") that Activation Keys are associated with is 
judged to be defective by Dialogic following its standard practices, Dialogic Support will issue to You replacement Activation 
Keys associated with the replacement device upon receipt by Dialogic of the failed device.  Replacement of the faulty device 
is subject to the terms of Dialogic's Hardware Warranty.

• You may copy the Program into any machine readable or printed form for backup in support of Your use of one copy of the 
Program;

• You may make one copy of Dialogic’s documentation provided that all copyright notices contained within the documentation 
are retained;

• You may transfer the Program, documentation and the license to another eligible party within Your Company if the other 
party agrees to accept the terms and conditions of this Agreement. If You transfer the Program and documentation You 
must at the same time either transfer all copies whether in printed or machine readable form to the same party or destroy 
any copies not transferred; 

• You may not rent or lease the Program. You may not reverse engineer, decompile or disassemble the Program. You may 
not use, copy, modify or transfer the Program and documentation, or any copy, modification or merged portion, in whole 
or in part, except as expressly provided for in this Agreement;

• You may not modify the Program in order to circumvent or subvert the protection mechanisms inherent in the program or 
attempt to use a time-limited Activation Key after it has expired;

• If You transfer possession of any copy, modification or merged portion of the Program or documentation to another party 
in any way other than as expressly permitted in this Agreement, this license is automatically terminated.

Term

The license is effective until terminated. You may terminate it at any time by destroying the Program and documentation 
together with all copies, modifications and merged portions in any form.

It will also terminate upon conditions set forth elsewhere in this Agreement or if You fail to comply with any terms or conditions 
of this Agreement at any time. You agree upon such termination to destroy the Program and documentation together with all 
copies, modifications and merged portions in any form.

Limited Warranty

The only warranty Dialogic makes, beyond the replacement of Activation Keys under the terms set out above, is that the 
medium on which the Program is recorded will be replaced without charge if Dialogic, in good faith, determines that it was 
defective in materials or workmanship and if returned to Your supplier with a copy of Your receipt within ninety (90) days from 
the date You received it. Dialogic offers no warranty for Your reproduction of the Program. This Limited Warranty is void if 
failure of the Program has resulted from accident, misuse, abuse or misapplication.

Customer Remedies

Dialogic’s entire liability and Your and Your Authorized Users exclusive remedy shall be, at Dialogic’s option, either (a) return 
of the price paid or (b) repair or replacement of the Program that does not meet the above Limited Warranty. Any replacement 
Program will be warranted for the remainder of the original Warranty period.

No Other Warranties

Dialogic disclaims all other warranties, either express or implied, including but not limited to implied warranties or 
merchantability and fitness for a particular purpose and the warranty against latent defects, with respect to the Program and 
the accompanying documentation. This limited warranty gives You specific legal rights. You may have others, which may vary 
from jurisdiction to jurisdiction.

No Liability for Consequential Damage

In no event shall Dialogic, its affiliates or its suppliers or their officers, directors or employees be liable for any damages 
whatsoever (including without limitation, damages for loss of business profits, business interruption, loss of information, or 
other pecuniary loss and indirect, consequential, incidental, economic or punitive damages) arising out of this Agreement or 
the use of or inability to use this Program, even if Dialogic has been advised of the possibility of such damages. As some 
jurisdictions do not allow the exclusion or limitation for certain damages, some of the above limitations may not apply to You 
or Your Authorized Users.

Limit of Liability

Dialogic's entire aggregate liability under any provision of this Agreement shall be limited to the amount actually paid by You 
for the affected Program.
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Right to Audit

If this Program is licensed for use in a Company, Your Company agrees to keep all usual and proper records and books of 
accounts and all usual proper entries relating to each installation of the Program during the term of this Agreement and for a 
period of three (3) years thereafter. During this period, Dialogic may cause an audit to be made of the applicable records and 
of the installations of the Program in order to verify Your compliance with this Agreement and prompt adjustment shall be 
made to compensate for any errors or omissions disclosed by such audit. Any such audit shall be conducted by an independent 
certified public accountant selected by Dialogic and shall be conducted during the regular business hours at Your offices and 
in such a manner as not to interfere with Your normal business activities. Any such audit shall be paid for by Dialogic unless 
material discrepancies are disclosed. 

For such purposes, "material discrepancies" shall mean the Company exceeding by three percent (3%) or more the number 
of licensed channels for any function of the Program or the Company exceeding the licensed number of Authorized Users by 
three percent (3%) or more. If material discrepancies are disclosed, Your Company agrees to pay Dialogic for the costs 
associated with the audit as well as the license fees for the additional licensed channels or additional Authorized Users. In no 
event shall audits be made more frequently than semi-annually unless the immediately preceding audit disclosed a material 
discrepancy.

Supplementary Software

Any Supplementary Software provided with the Dialogic Program referred to in this License Agreement is provided "as is" with 
no warranty of any kind.

U.S. Government Restricted Rights

The Program and documentation are provided with RESTRICTED RIGHTS.  Use, duplication or disclosure by the U.S. 
Governments is subject to restrictions as set forth in subparagraph c) 1) ii) of The Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013 or subparagraph c) 1) and 2) of the Commercial Computer Software-Restricted Rights 
at 48 CFR52.227-19, as applicable.  

Governing Law

This Agreement shall be construed and controlled by the laws in force in the Province of Quebec, Canada with the exception 
of its conflict of laws rules. The United Nations Convention on Contracts for the Sale of Goods does not apply to this Agreement.

Miscellaneous

All rights and remedies, whether conferred hereunder or by any other instrument or law, will be cumulative and may be 
exercised singularly or concurrently.  Failure by either Dialogic or You to enforce any term will not be deemed a waiver of 
future enforcement of that or any other term.  The terms and conditions stated herein are declared to be severable. Should 
any term(s) or condition(s) of this Agreement be held to be invalid or unenforceable the validity, construction and enforceability 
of the remaining terms and conditions of this Agreement shall not be affected.  You may not assign any rights, duties or 
obligations hereunder without the prior written approval of Dialogic and any attempt to assign any rights, duties or obligations 
hereunder without Dialogic's written consent will be void.  It is expressly agreed that Dialogic and You are acting as independent 
contractors.  These terms and conditions constitute the entire agreement between Dialogic and You with respect to the subject 
matter hereof.  These terms and conditions will prevail notwithstanding any different, conflicting or additional terms and 
conditions that may appear on any other agreement between Dialogic and You.  Deviations from these terms and conditions 
are not valid unless agreed to in writing in advance by an authorized representative of Dialogic. Any notice to Dialogic under 
this Agreement must be sent by courier or registered mail to the attention of Dialogic’s legal department at the address below.

Contractor/ manufacturer is: 

DIALOGIC CORPORATION. 

9800 Cavendish Blvd., Montreal, Quebec, Canada H4M 2V9

This Agreement has been drafted in English at the express wish of the parties.  Ce contrat a été rédigé en anglais à la demande 
expresse des parties.
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About This Publication

How to use this guide

• To view a section, click the corresponding bookmark located on the left.

• To view a topic that contains further information, click the corresponding blue underlined phrase.

• You may wish to print out the pages required for installing the drivers.

Structure of this guide

This guide provides a detailed description of how to install and configure the Dialogic® Diva® softIP software.

This guide is structured as follows:

Section Contents

About the Dialogic® Diva® softIP 
Software

Diva softIP features and requirements for software installation

Software Installation Installing Dialogic® Diva® softIP software drivers

Software Configuration Starting a configuration with an installed Dialogic® Diva® softIP board and activating 
the license

Uninstalling Uninstalling Diva softIP software

Maintenance Tools Debugging tools for locating installation errors or connection problems

Management Tools Tools for monitoring active connections and getting statistic information on all 
connections

Customer Service Information on how to get technical support for Dialogic products
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CHAPTER 1

About the Dialogic® Diva® softIP Software

The Diva softIP software is middleware that enables existing voice and fax applications - based on the Dialogic® 

Diva® Software Development Kit, ISDN CAPI 2.0, TAPI, and Port driver standard - to be fully integrated into 

Voice over IP networks. Technically speaking, the Diva softIP software is comparable to an ISDN media board 

in that it provides functions such as voice and fax transmission, DTMF tones and supplementary services as well 

as conferencing between ISDN and VoIP connections. Through use of the Diva softIP software, you can do such 

things as several ISDN media boards and use Voice over IP simultaneously, allowing you to couple traditional 

and state-of-the-art telephony services. 

General features

• IP only configuration, software only (Host Media Processing)

• Support for mixed installation, i.e., Dialogic® Diva® hardware and Dialogic® Diva® softIP software in one PC

• Support for up to 120 channels

• Basic Call origination, termination, and Supplementary Services

• Diva API (SDK) support

• TAPI support

• CAPI 2.0 support

• Port driver support

• Tool to map between phone numbers and SIP URLs

• Licensing per PC fingerprint or USB dongle

• Support for Combined Board (The Combined Board abstracts the underlying Diva Media Board based channel 

segmentation into one media board towards the application interfaces (APIs), e.g., from 4 x 30 channels to 

1 x 120 channels.)

• Automatic Resource Management using the Combined Board

• Calls that are initiated without the need to allocate hardware DSP resources (e.g. voice) are preferably 

routed via the Diva softIP software. If all available channels of the Diva softIP software are used and no 

channels of the Dialogic® Diva® Media Board are reserved for DSP usage, the remaining DSP enabled 

channels of the Diva Media Board are also used for non DSP related calls (e.g. voice).

• The call characteristic may change during a call and therefore require a switchover from the Diva softIP 

board to the Diva Media Board or vice versa. In this case, the Combined Board reroutes internally the call 

using the required resources. 

• Internal Service CAPI interface

Dialogic® Diva® API (SDK) support

• IP only configuration, Host-Media Processing, software only

• TDM/IP hybrid configuration, mixed with Diva Media Boards

VoIP / CAPI 2.0 support

• Calling Party Number (inbound/outbound calls), including International Numbering Plan according to E.164 

mapped to "+" 

• Called Party Number (inbound/outbound calls), including International Numbering Plan according to E.164 

mapped to "+" 

• Redirecting Number, SIP Diversion Header (according draft-levy-sip-diversion-06.txt) mapped to 

Redirecting Number including International Numbering Plan according to E.164 mapped to "+"

• B-channel protocols, 64 Kb bit-transparent, Transparent, T.30*

• Fax support (T.30)*, MH, MR, MMR, ECM
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• DTMF recognition and generation (inband and out of band according to RFC 2833)

• Line Interconnect 

• Conferencing using Line Interconnect

• Call Transfer without consultation call (also known as Blind Transfer, Call Deflection or Single Step Call Transfer 

in active state).   

• Explicit Call Transfer with consultation call with primary call on hold.

• Explicit Call Transfer with consultation call with primary call not on hold.

TAPI support

• Line Interconnect

• Conferencing

VoIP Call Control

• Session Initiation Protocol (SIP) according to RFC 3261 

• Further SIP Methods: NOTIFY (RFC 3265), REFER (RFC 3515), SUBSCRIBE (RFC 3265), REGISTER (RFC 3261) 

with Digest Authentication, OPTIONS (RFC 3261)

• Session Description Protocol (SDP) according to RFC 2327

• SIP side Call Transfer (known as ECT) as transfer target (C-party) and as call initiator (A-party).

• Support of the SIP Register feature including HTTP Digest Authentication. This scheme is using a simple 

challenge/response mechanism and a shared secret between the two servers.

• SIP Diversion Header (according draft-levy-sip-diversion-06.txt) 

• Proxy Authentication 407, Invite Authentication

• Proxy and Registrar address can be configured differently. REGISTER request can be sent to Registrar and 

INVITE to Proxy. 

• SIP Signaling Proxy support if a Registrar is behind a Proxy

• Support of the SIP side Explicit Call Transfer 

• Allow to have the port numbers (SIP and Media) configurable (also as a range of port numbers).

For more information about Proxy and Registrar configuration, see the Dialogic® Diva® softIP software Online 

Help file (DSsoftIP.chm)

Fax services

• T.38* for real-time fax over IP

• T.30* Fax Group 3 using T.38, up to 33.6 kbps (SuperG3 Fax). 

Note: The availability of the line speed depends also on the gateway or the remote IP Fax terminal.

• Fax* compression MH, MR, MMR

• Error Correction Mode (ECM)*

* Based on T.38 without own Soft Fax stack, feature depends on VoIP Gateway/Terminal.

Media Streaming

• PSTN standard codec, G.711, 64 kbps a-law / µ-law 

• RTP/G.711 Clear Channel Fax to CAPI/SDK SFF Fax (incl. all existing T.30 and error correction features)
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Tone handling

• Inband DTMF generation and detection (clear channel)

• DTMF generation and detection via RTP event (RFC 2833)

• Basic call origination and termination

Supplementary Services support

• Numbering Services (Called Party Number, Calling Party Number, Redirecting Number supporting also 

International E.164 format)

• Call Hold/Retrieve

• Call Transfer without consultation call, in active call state (also known as Blind Transfer/Call Deflection in 

active state or Single Step Call Transfer).   

• SIP side Call Transfer (known as ECT) as transfer target (C-party) and as call initiator (A-party).

• Conference using Line Interconnect (see VoIP / CAPI 2.0 support on page 8)

• Message Waiting Activation/Deactivation (to activate/deactivate MWI lamps on remote phones, e.g., 

connected via a gateway or on IP phones)

Dialogic® Diva® Media Board support

• The Diva Media Boards can be combined with the Dialogic® Diva® softIP software v2.2

The Diva softIP software v2.2 installation tool considers the Diva Media Boards already installed.

• Dialogic® Diva® 4BRI-8 PCI, 4BRI-8 PCIe, PRI/E1-30 PCI, and PRI/E1 PCIe Media Boards can be used as 

resource boards. In this mode, all external interfaces are disabled and the media board functions only in 

combination with the Diva softIP software and thus provides enhanced media processing functions to voice 

and fax connections delivered as RTP streams.

Requirements for software installation

For the installation of the Dialogic® Diva® softIP software, the following requirements have to be met:

• Windows® XP 32-bit version (with Service Pack 2 or higher), Windows Server® 2003 32-bit version (with 

Service Pack 1 or higher), Windows Vista® 32-bit version (with Service Pack 1 or higher) operating system 

• System requirements recommended from Microsoft for the respective operating system

• Computer with USB interface for USB dongle

• An installed NDIS 5 compatible network controller

Notes: 

• For Windows® XP, you have to deactivate your firewall.

• The Diva softIP software cannot be installed on a Terminal Server.

Information on installing downloaded software

If you downloaded the Dialogic® Diva® softIP software from the Dialogic web site, please note the following:

• Extract the files to your hard disk drive. Do not change the directory structure of the extracted files.

• This reference guide assumes that the installation files are copied into the directory C:\Temp\softIP.
If necessary, change the drive letter or path according to your system configuration.
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CHAPTER 2

Software Installation

Important:  If you activate your license via the USB dongle, which came with your Dialogic® Diva® softIP 

software package, do not plug the dongle into the USB port on your computer until the Dialogic® Diva® softIP 

software installation is complete.

Notes: 

• You must log on with administrator rights to install the Diva softIP software.

• If you use a Dialogic® Diva® Media Board additionally to the Diva softIP software, the drivers of the Diva 

softIP software are installed together with the drivers of the Diva Media Board. See the Dialogic® Diva® 

System Release Reference Guide for more information. 

• To use the Diva softIP board, you need to purchase a license and activate it in the Dialogic® Diva® Configuration 

Manager. Only after having activated the license, you can add the Diva softIP board to the boards pane in 

the Diva Configuration Manager and configure it.

1. Close all CAPI applications. 

2. If you have a former version of the Diva softIP software installed, uninstall it before you continue with the 

installation. The complete uninstallation of former versions ensures that all components of the current version 

are installed correctly. 

3. If you want to install the Diva softIP software from the Dialogic® Diva® System Release CD-ROM, insert the 

CD-ROM into the CD-ROM drive. The welcome screen should appear automatically. If the welcome screen 

does not appear, click Start > Run and type D:\SETUP.EXE (where D: is your CD-ROM drive letter). Start 

the installation of the software from the "Installation" menu. 

4. If you downloaded the softIP drivers from the Dialogic web site, go to the directory in which you saved the 

files, and double-click the "Setup.exe" file.

5. In the welcome dialog box, click Next to start installing the Diva softIP drivers.

6. If you install the drivers from the Diva System Release CD-ROM, the License Agreement box appears. 

Read the license agreement carefully. If you accept it, select I accept the above license agreement and 

click Next. If you do not accept it, click Cancel to exit the process. You need to accept the license agreement 

to be able to install the drivers.
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7. In the Installation Mode box, select if you want to install the Dialogic® Diva® Media Board in default mode, 

customized mode, or secure mode. 

• If you select Default installation, the CAPI is installed. Click Next and go to step 13 on page 14 to 

continue with the installation.

• If you select Customized installation, you can specify the services that are to be supported. Click Next 

and go to step 9 on page 13 to continue with the installation.

• If you select Secure installation, you can set security settings for the various services and interfaces. 

Additionally, you can set a password to prevent unauthorized users from changing the settings. Click Next 

and proceed with the following step.

Note:  The services that you deactivate during the installation are not available in the Dialogic® Diva® 

Configuration Manager. You have the opportunity to use these services if you activate them in the Dialogic® 

Diva® Configuration Wizard. See Changing the installation: on page 15.

8. In the Security Settings box, the possible services and interfaces are selected. Disable the services or 

interfaces you do not want to use for security reasons. You can set a password to prevent unauthorized 

users from changing the settings.

Click Next.
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9. In the Service and Interface Selection box, select the services and interfaces you need for your system. 

If you selected Secure Installation, the services and interfaces you disabled in step 7 on page 12 cannot 

be selected anymore. Click Next.

10. If you selected the service Modem via serial port and TAPI (Unimodem), the Modem Installation box 

appears.

The Dialogic® Diva® softIP software supports the Dialogic® Diva® Fax Modem. For more information about 

this modem, see the Dialogic® Diva® Configuration Manager Online Help file - DSMain.chm.

If you do not want to use one modem per B-channel, select Specify the number of modems you would 

like to install and enter the number of modems. Click Next.



Software Installation

page 14

11. In the Incoming Call Policy box, select how to handle incoming calls.

Click Next.

12. The WIBU-KEY software box appears. If you use your Diva softIP software with a WIBU-KEY, you need to 

install the software for this key.

13. In the displayed dialog box, the selected options are listed.

Click Back if you need to change the settings. Click Install to copy the appropriate files to your system.
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14.When the copy process is complete, click Finish to complete the installation.

Note:  Depending on your system configuration, you are prompted to restart your computer. Make sure that 

the Restart your computer option is selected after the installation is complete.

You can now open the Dialogic® Diva® Configuration Manager and configure the Dialogic® Diva® softIP software. 

See Software Configuration on page 16 or consult the Diva Configuration Manager Online Help file - DSMain.chm.

Changing the installation:

If you have already installed the drivers and you need to change the installation options:

1. Click Start > Programs > Dialogic Diva > Configuration Wizard. The Dialogic Diva Configuration 

Wizard box appears. If you did not set a password during the update, click Next. If you set a password, 

enter it, and then click Next. 

Note:  If you change the configuration, existing settings will be overwritten.

2. Proceed as described in step 7 on page 12.
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CHAPTER 3

Software Configuration

To use the Dialogic® Diva® softIP board, you need to purchase a license and activate it in the Dialogic® Diva® 

Configuration Manager. Only after having activated the license, you can add the Diva softIP board to the boards 

pane in the Diva Configuration Manager and configure it. 

License activation

After you have installed the Dialogic® Diva® softIP software, you need to activate your license to unlock 

functionality in the product. A free test license for 30 days and 2 channels (voice and fax) is available on the 

Dialogic web site.

To activate your license, you need the following information:

• Device Unique ID (DUID)

• Proof of Purchase Code (PPC)

As soon as you have both, visit the Dialogic® Diva® Activation page to register your PPC together with the DUID 

and you will receive your license file. Activate this license file in the Dialogic® Diva® Configuration Manager. For 

more information see License key.

Device Unique ID (DUID)

The DUID binds the installed Diva softIP software to your hardware. This may be either your PC (PC fingerprint) 

or a WIBU-Key USB dongle.

To get the Device Unique ID:

1. Click Start > Programs > Dialogic Diva > Configuration Manager. 

2. In the Diva Configuration Manager, click Tools > License Manager. 

3. On the left side of the License Manager box, click Available DUIDs on this system so that it is highlighted. 

4. If you have a WIBU-Key dongle inserted in your PC, you may select between your system DUID (PC 

fingerprint) and the DUID of the dongle. Select the DUID you want to use.

5. On the right side, click Copy DUID to clipboard. 

6. If you need to do the web activation using another computer, open an editor, paste the DUID, and save the file.

Proof of Purchase Code (PPC)

When you purchase the Dialogic® Diva® softIP license you receive a PPC either in printed form or as email. By 

registering this PPC, you represent and warrant that you lawfully purchased the license.

http://www.dialogic.com/products/ip_enabled/Diva_IP_Software_SIP.htm?dl=1&regID=19473
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To register your PPC and DUID:

1. Open the following web site: http://www.dialogic.com/activate. 

2. Enter your PPC and click Check.

http://www.dialogic.com/activate/akiweb_reg.asp
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3. If your PPC is valid, the following web site will open:

Paste your Device Unique ID (DUID) that you saved earlier, and enter your e-mail address to which the 

license file should be sent. 

4. Click Activate to generated the license file that will be sent to the e-mail address you entered.

5. You will receive an e-mail from Dialogic with your license key. Save the license key.

License key

To activate the license:

1. Open the Diva Configuration Manager and click Tools > License Manager.

2. Click Add License and go to the directory where you saved the license key.

3. Select it, and click Open.

4. Your license key is now added to the License Manager.

5. Click Close to close the License Manager.

6. Now the Diva softIP functionality is unlocked for the feature set you acquired with your license.

Insert the Dialogic® Diva® softIP software into the Dialogic® Diva® Configuration Manager

After you activated the license for the Diva softIP software as described above, you can add the Diva softIP 

software to the Dialogic® Diva® Configuration Manager: 

1. Click Start > Programs > Dialogic Diva > Configuration Manager. 

2. To insert the Diva softIP software, click Insert > Dialogic Diva softIP Board.
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See below an example of a default installation for a virtual Diva softIP board:

The Dialogic® Diva® Configuration Manager Online Help file - DSMain.chm contains detailed information 

about the configuration of the properties.
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CHAPTER 4

Uninstalling

To uninstall your Dialogic® Diva® softIP board, use Dialogic® Diva® Uninstall as follows:

Note:  With Diva Uninstall not only the Diva softIP board but all installed Dialogic® Diva® Media Boards will be 

uninstalled.

1. Click Start > Programs > Dialogic Diva > Diva Uninstall. 

2. The welcome dialog box is displayed. Follow the instructions on the screen and click Next to continue.

3. In the Confirm Uninstall box, all installed Diva Media Boards are displayed:

Click Next to uninstall the Diva softIP board and its related drivers.

4. In the displayed dialog box, select if you want to shut down or restart your computer now or later.

Click Finish, to complete the process.
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CHAPTER 5

Maintenance Tools

The Dialogic® Diva® softIP software offers the following tools for testing your connection and diagnosing and 

solving problems that might occur with your virtual Dialogic® Diva® softIP board or the connection:

• Dialogic® Diva® Line Test tool see below

• Dialogic® Diva® Diagnostics tool on page 21

Dialogic® Diva® Line Test tool

To use the Diva Line Test tool, you must have installed your Diva softIP software, connected your network adapter 

to the network, and bound your IP line to the virtual Diva softIP board shown in the Dialogic® Diva® Configuration 

Manager.

1. To open Diva Line Test, click Start > Programs > Dialogic Diva > Line Test.

2. The Dialogic Diva Line Test box opens.

Diva Line Test offers the following tests:

• Line Check: 

Performs a quick check of your physically installed Dialogic® Diva® Media Board and the physical connection.

Note: The line check is only available for physically installed Diva Media Boards. For the Diva softIP board 

use the "Phone/Loop Test" to check the line. 

• Phone/Loop Test: 

Performs basic inbound or outbound phone tests, to test the connection to other telephones or to itself.

• Call Transfer Test: 

Performs different call transfer tests, with the option to choose the transfer type.

Note: With the virtually installed Diva softIP board only a Blind transfer without consultation call can be 

performed.

• Fax Test: 

Performs basic inbound or outbound fax tests.

For more information about the tests, see the Dialogic® Diva® Line Test Online Help file (DSLineTest.chm). 

Dialogic® Diva® Diagnostics tool

The Dialogic® Diva® Diagnostics tool can help with the analysis of problems if you encounter difficulties with the 

Dialogic drivers or the connection. 

Every Dialogic driver sends status messages and reports any error that occurs. The messages are saved in a 

specific memory area of a fixed size, so that the oldest messages are overwritten when the memory is full. 

Diva Diagnostics enables the messages from your virtual Dialogic® Diva® softIP board and various drivers to be 

displayed and saved.

1. To open the Diva Diagnostics tool, click Start > Programs > Dialogic Diva > Diagnostics.

2. The left pane of the tool displays the installed drivers. If you click on a driver, the available trace options are 

displayed in the right pane.

For more information on Diva Diagnostics, see the Dialogic® Diva® Diagnostics Online Help file (DivaTrace.chm). 
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CHAPTER 6

Management Tools

Dialogic® Diva® Management tool

The Diva Management tool is integrated into the Microsoft® Management Console (MMC) via a snap-in. You may 

create your own set of management, for instance the Device Manager combined with the Diva Management tool.

Diva Management is a tool that displays the current status of the connected lines, the active connections and 

the history of connections. Simply testing lines and connectivity is also part of the Diva management tool. 

To open Diva Management as standalone program, click Start > Programs > Dialogic Diva > Management.

Diva Management offers the following statistics:

• Status:

Displays an overview of your installed Dialogic® Diva® softIP board and the events taking place on the media 

board.

• Active Connections:

Displays the virtual Diva softIP board with active incoming or outgoing calls.

• Call History:

Displays the history for all conducted ingoing or outgoing calls.

For more information about the statistics see the Dialogic® Diva® Management Online Help file 

(DivaServerManagement.chm). 
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CHAPTER 7

Customer Service

Dialogic provides various options and arrangements for obtaining technical support for your Dialogic® product. 

We recommend that you use the Dialogic® Diva® Support Tools first before contacting your Dialogic supplier. 

Also, we suggest that you visit our help web, which includes detailed information about a variety of topics. In 

the unusual case that neither your supplier nor the information on the help web can adequately address your 

support issue, contact our Customer Support.

For more information see:

• Dialogic® Diva® Support Tools

• Dialogic Corporation Help Web

• Dialogic Corporation Customer Support

Dialogic® Diva® Support Tools

If a problem occurs during the operation of your Dialogic® Diva® product, use the following Dialogic® Diva® 

Support Tools:

• Dialogic® Diva® Line Test tool: With the Diva Line Test tool, you can test your hardware and perform simple 

phone test calls, call transfers, or basic inbound and outbound calls.

• Dialogic® Diva® Diagnostics tool: With the Diva Diagnostics tool, you can write traces for each media board 

or driver into a file.

• Dialogic® Diva® Management tool: With the Diva Management tool, you can view the current status of the 

connected lines, the active connections, and the history of the connections.

For more information about the tools, see the respective online help file.

If you cannot solve the problem with the tools, contact your Dialogic supplier. 

Dialogic Corporation Help Web

If your supplier is unable to help you to solve your problem, visit the Dialogic Help Web. It contains detailed 

information on such subjects as:

• Installation and upgrade of Dialogic® Diva® drivers, configuration scenarios, and applications.

• Diagnostic and testing utilities.

• Basic issues, error messages and how to resolve them.

• "How to" guides and wizards.

• Online training for ISDN, Dialogic® Diva® API, and X.25 is offered by Dialogic. The training is aimed toward 

technical support people, but much of the courses are also suitable for a non-technical audience.

For more information, visit our Help Web at www.dialogic.com/support/helpweb. 

Dialogic Corporation Customer Support

If the information on the Dialogic Help Web was not sufficient to help you solve your problem, contact Dialogic 

Customer Support. 

To provide help, Dialogic Customer Support will likely need from you:

• A debug trace (see Dialogic® Diva® Diagnostics Online Help file - DivaTrace.chm), and

• A copy of your active configuration (see Dialogic® Diva® Configuration Manager Online Help file - 

DSMain.chm).

See www.dialogic.com/support/contact for details on how to contact us.

http://www.dialogic.com/support/helpweb
http://www.dialogic.com/support/contact 
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